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GENERAL GUIDELINES – ALL QUESTIONS  

- Questions for all sections of the examination must be 
multiple-choice, single best answer. 

- Avoid the use of imprecise terms such as may, often, 
frequently, and absolutes such as always and never. 

- The ABPath does not use the possessive case with eponymic 
terms, e.g., Down syndrome. 

o Use generic terms instead of eponymic terms 
whenever possible. 

- Do not use fictitious or obscure terms. 
- Avoid the use of proprietary names. 
- Because reference ranges vary widely, list the reference 

values when units of measure or laboratory values are used.  
- Present data in tabular form when it makes a question easier 

to read. 
- Titers should be expressed as the reciprocal without the 1:__, 

that is, 32, not 1:32. 
o Dilutions and ratios, however, are expressed as 1:__. 

- Special characters may be added in the stem or distractors 
by clicking on the Omega symbol in the heading of each 
stem/distractor entry box, and selecting the special character needed. These functions are in progress, not 
currently available. 

- When questions are edited, finalized, and moved to the permanent item bank by the ABPath staff, the 
answers will automatically be alphabetized. If you do NOT want the answers in alphabetical order (e.g., a 
listing of diagnoses in order of benign to malignant), uncheck the “Alphabetize Distractors” button in the 
question template. 

 

QUESTION CONTENT 

- The content of the question should emphasize: 

▪ Important information that each candidate should 
need to know on a daily basis. 

▪ Information that is clearly appropriate for the level of 
the examination (i.e., primary, subspecialty 
qualification, or continuing certification). 

- Avoid controversial topics for questions. 

- Do not base questions on one specific article giving one piece of 
information. Items should be able to be answered from more 
than one source. 

  

Understanding 
Abbreviations 

Only use well-known abbreviations that 
have been accepted by the TDAC – 
Resource Document: Acceptable AP CP 
Abbreviations 

If the abbreviation is not accepted, place 
abbreviation in parentheses after the 
spelled-out term, e.g., diethylstilbestrol 
(DES) → Thereafter, abbreviation may be 
used alone. 

If the term is not used again, omit the 
abbreviation, unless it is essential to the 
candidate’s recognition of the term. 

“Important information 
that each candidate 
should know on a daily 
basis.” 
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STEM 

- State a single, clearly formulated problem as a question. 
o “What is the most likely diagnosis for this (location) biopsy/lesion from a #-year-old 

male/female/patient?” 
- Place terms or phrases that are common to all distractors in the stem. 
- Short stems with only necessary information are best. Omit excessive verbiage and be sure that the 

stem is a complete thought. 
- Do NOT place information in the stem that will teach or give a clue to the answer, especially grammatical 

clues: 

 

 

 

 

 

 

 

 

 

 

- The use of “except” questions and other negative stems are NOT permitted. 
- All questions should be written in the past tense. 
- Age and sex on patient-based questions may be used at your discretion. 
- You may use male/female, man/woman, boy/girl, etc. 
- If absolutely necessary, refer to race as Black/White/Asian/Hispanic/Native American/country of origin. 

Race or ethnicity should only be included when appropriately relevant. 
- No stems with personal pronouns (e.g., “You are asked” or “In your lab”). 
- TRUE/FALSE QUESTIONS ARE NOT PERMITTED (e.g., “Which statement regarding ‘X’ is true/correct?”). 
- An ideal question is one that meets the “cover the options” rule, that is, the candidate should be able to 

cover the distractors and answer the question just by reading the stem. 
- Omit “of the following” unless there could be other correct answers not listed in the choices for that 

question (e.g., “Which of the following protein function is encoded by high-risk HPV genes?”). 

  

The most likely cause is a 

A. acute uncompensated respiratory acidosis 

B. chronic respiratory acidosis 

C. decreased alveolar-arterial gradient 

D. error by the laboratory 

E. metabolic alkalosis respiratory compensation 

Osmosis from Elsevie 

AN IDEAL QUESTION IS ONE THAT MEETS THE “COVER THE OPTIONS” RULE. 
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DISTRACTORS 

- If possible, answer choices should be approximately the same length and grammatically similar. 
- Answer choices must be homogeneous (e.g., all IHC stains, all diagnoses, all lab results, etc.). 
- All must be viable options that should NOT be easily narrowed down to two choices. 
- They should NOT BE easily groupable by the candidate (e.g., four benign diagnoses and one malignant 

one). 
- “All of the above” or “none of the above” are NOT PERMITTED as answer choices. 
- Start in lower case unless the distractor is an independent sentence or begins with a proper name. 
- Do not place a period at the end of the distractor unless the answer choice is a full sentence. 

 

GENERAL GUIDELINES – PRACTICAL SELECTIONS OF THE EXAMINATION  

- Image and VM questions may be a simple identification/diagnosis or may be 2nd-order questions. 
Submission of the latter is encouraged. 

- Practical question submission with visual aids must include the anatomic site and diagnosis on the 
question template. 

- Images must follow HIPAA guidelines for patient 
confidentiality. 

- Carefully and fully identify visual aid materials. Save your 
file using the computer-generated submitter accession 
number from the entered question. This will prevent mix-
ups among similar questions and visual aids. 

- If needed, label the image with the magnification of 
photomicrographs, unless the question tests for that 
information. (See “Adding a Text Box to an image”.) 

- Visual aids should illustrate the problem with a minimum 
of extraneous information. 

- Visual aids must have clear legend information or be 
explained in the stem of the question. 

- When necessary, indicate the problem illustrated in the visual aid by an arrow or other mark, and note it in 
the stem. (See “Adding an Arrow to an image”.) 

- Visual aids must contain information needed to answer the question. 
- Visual aids should not be from a study set (e.g., pictures to which some, but not all, of the candidates 

might have access). 
- Visual aids, like questions, must not use copyrighted material. 
- Public domain images (from the internet) may be used, the best being Wikimedia Commons. A tutorial to 

determine if an image is public domain is available – Resource Document: Acquisition and Use of Web 
Images. 

 

What is a 2nd-order question? 

2nd order questions require candidates to 
be able to decipher the diagnosis, before 
answering the pointed question asked in 
the stem. 

A 1st order question would be one that 
may just straightforwardly ask for the 
diagnosis. 

https://commons.wikimedia.org/wiki/Main_Page
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IMAGES 

- Accepted images may be used on primary or subspecialty examinations. 
- Images are used to illustrate findings that cannot be well or consistently demonstrated as a VM. 
- Images of a microscopic field should focus on a specific histologic finding. 
- Images must be clear, bright, sharp, and in focus. 
- Generally, at least a low-power and a high-power image should be submitted. 
- For practical with image questions, six (6) images will be accepted, up to four (4) images will be utilized 

during examination. 

 

VIRTUAL MICROSCOPY 

- Microscopic glass slides or SVS files should be submitted to 
the ABPath office by the question submission deadline. 
(Resource Document: Shipping Glass Slides and Thumb Drives) 

- Submitting two (2) glass slides for each case is requested, but one 
slide is acceptable in cases when there is only a single slide, i.e., 
frozen sections. 
- The question entry accession number must be written on the 
frosted end of the slide. Please do NOT affix labels, as the ABPath 
will use their own labels. 
- SVS files must be named with the question accession number. 

- The slides should be representative of the lesion and be technically high quality, with adequate fixation, 
and without folds, holes, or knife marks. 

- Slides with plastic coverslips will not be accepted. 
- Up to six (6) images to select from may be included with the microscopic questions and are encouraged for 

immunohistochemistry. A maximum of two (2) images will be used with the final question, using only one 
(1) image being the favorable option. The question should still be coded as microscopic, rather than coded 
as an image question. 

- Take all dots/marks off the slides, with the exception of gyn cytology slides. Please clearly indicate 
cytology slides that should not have markings removed. 

- For cytology, do NOT submit SurePath slides because they are not monolayer. 
- The hematology and cytology VM slides should have enough diagnostic groups/cells and not be too thick. 

Thick areas that require focusing are difficult to scan and visualize. 
- Ideally, tissue should be NO LARGER than 1 cm x 1 cm. 
- If the tissue is larger than 1 cm or is a smear with a particular diagnostic area, make a photocopy of the 

slide at 200% enlargement, and mark on the photocopy the smallest areas possible which should be 
annotated (cropped). 

- Accepted slides will not be returned. 
- The ABPath will reimburse up to $7.00/glass slide for each accepted case, after you submit the remaining 

slides and an invoice. 
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FIGURES 

- On some practical questions, figures or illustrations are used. These may be karyotypes, diagrams, graphs, 
maps, charts, or any appropriate image. Figures should be submitted online with the question. 

 

 

ELECTRON MICROGRAPHS 

- Electron micrographs (EMs) should be submitted as high-resolution digitized images. 
- EM questions should only be submitted if electron microscopy is still used for diagnostic purposes. 

 

 

CATEGORY CODES 

- The computer will not save your question without a category 
code being chosen. 

- The category code should be the most granular/specific code, 
which is often the diagnosis. 

o Do not use a main heading code (e.g., soft tissue tumors), 
a technique code (e.g., flow cytometry, special stains, IHC, 
FISH, etc.), or a specimen type code (e.g., blood 
smear, FNA, cytospin, etc). 

- A copy of the category codes for each TDAC can be found in 
Govenda, within each specific TDACs document file, as 
well as in the new question submission section of the TDAC 
question submission site. 

 

  

Please be thoughtful in your 
selection of category code. 

Helpful Hint: Use Ctrl+F + a keyword to 
make finding the best, most granular, 
category code a far simpler task. 
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INSTRUCTIONS FOR ENTERING QUESTIONS  

LOG IN TO THE QUESTION ENTRY SITE  

https://tdac.abpath.org/ 

- All TDAC questions and images are submitted online. 
- When the assignment for your TDAC meeting was sent, you were instructed to access the website then 

create your own password. 
- The username is the first letter of your first name plus your last name (e.g., “jdoe”) or your email address. 
- The temporary password is ABP@th123. 

 

- Once you log in, you will select “Question Submission” from the toolbar. 
- From the dropdown box of TDAC names, click on your TDAC name and a blank question template will 

appear. 
- Enter your name and email address, then complete the template as instructed. 
- If you would like to review the questions you have submitted, click on “Question Submission” and select 

“Individual Item Review” and your TDAC name. 

 

 

INSTRUCTIONS FOR UPLOADING IMAGES  

- JPEG (.jpg) image(s) should be uploaded with the question submitted online. 
- The question must first be saved before an image can be uploaded. 
- Up to six (6) images can be uploaded for each question. 
- Images should be high resolution and up to 5,000 pixels wide x 5,000 pixels high or less, but no smaller 

than 1,000 pixels wide x 563 pixels high. 
- If you are submitting multiple images, upload the gross image first (if applicable) and then progress from 

low-power to high-power images. 

An easy way to resize images before uploading is to: 

1. Have your image up on the screen. 
2. Right-click on it and open with “Paint” (or go to “open” and select Paint). 
3. Click on “resize.” 
4. Change “percentage” to “pixels” by clicking on the button. 
5. Change whatever is the largest number (either horizontal or vertical) to 5,000 and click OK. The number will 

automatically change to the correct size. 
6. Save the file using the item’s assigned accession number and exit. 

For more information – Resource Document: Instructions for Resizing Still Images 

https://tdac.abpath.org/
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TROUBLE REPLACING AN IMAGE  

If you are having trouble replacing an image, the issue is probably with the web browser settings. The “cookies” are 
remembering your old image. To correct this problem, follow these steps: 

1. Close Google Chrome. 
2. Reopen Google Chrome. 
3. If you continue to have the same problem, click the three dots in the upper right corner of the screen; a 

dropdown should then appear. 
4. Select “Settings” and scroll down to “Privacy and Security.” 
5. Select “Clear Browsing Data” and ensure “Advanced” is in bold blue letters and underlined in blue. 

Beneath “Time Range” ensure that these checkboxes are selected: 
• Browsing history 
• Download history 
• Cookies and other site data 
• Cached images and files 

6. Click on “Clear Data” in the bottom right corner of the pop-up window. 
7. Once done, close the web browser, log in to the question website again, and try the image upload/deletion 

process again. 

 

 

INSTRUCTIONS FOR SCREEN CAPTURE  

PREPARE YOUR SCREEN 

1. Make sure the image on your screen is exactly as you would like it to appear. 
2. Make sure the image fills your screen, so you have the highest resolution possible. 
3. In Word, use View > Read Mode and adjust the zoom so that the image fills the screen. 
4. In Excel or PowerPoint, adjust the zoom so that the image fills the screen. 

You can use either Paint or the Snipping Tool to capture an image. If you do not already use Snipping Tool or Paint, 
you may want to pin them to your taskbar, so that they are readily accessible. 

 

HOW TO PIN TOOLS TO YOUR TASKBAR  

PAINT 

1. Click the Start button. 
2. In the Search field, replace Search programs and files with “Paint.” Paint will appear in the search results. 
3. Right-click on Paint and click “Pin to Taskbar.” 
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Snipping Tool 

1. Click the Start button. 
2. In the Search field, replace Search programs and files with “Snip.” Snipping Tool will appear in the search 

results. 
3. Right-click on Snipping Tool and click on “Pin to Taskbar.” 

 

SCREEN CAPTURE ON A PC USING PAINT  

1. With your complete image on the screen, press the “Print Screen” key on your keyboard to copy the screen 
image into memory. Some keyboards may shorten this to “Prnt Scrn” or “PrntScr.” Additionally, some 
laptop computers may have “Print Screen” sharing a key with another function, meaning that you must 
hold down the “fn” key to use the “Print Screen” function. 

2. Open Paint (usually found in the “Accessories” folder) and click “Paste” or press “Ctrl+V.” 
3. You may need to do some editing to eliminate parts of the image that were captured but not needed. 

Please see below or refer to “Help” in Paint or go to – http://windows.microsoft.com/en-
us/windows/using-paint#1TC=windows-7 

4. Click “Save As,” save as type “.jpg,” and select where you want to save the image, giving it the appropriate 
file name – name of the item’s assigned accession number. 

 

SCREEN CAPTURE ON A PC USING SNIPPING TOOL  

1. With the image on the screen, open Snipping Tool. 
2. Your screen will change to gray, indicating the Snipping Tool is active. 
3. Drag the cursor around the area you want to capture. 
4. On the Snipping Tool toolbar, click the Copy icon. 

 

SCREEN CAPTURE ON A MAC 

Press the Apple key+Shift+3 all at the same time. You will find a capture of the screen on your desktop named 
“Picture.” 

 

ADDING AN ARROW TO AN IMAGE 

1. Open the image in Paint. 
2. Select the arrow icon you want to use. 
3. In the image, left-click and hold the mouse to place and adjust the arrow size. 
4. Let go of the mouse and click outside of the arrow box, somewhere in the image. 
5. Click on the “Save” icon. 

http://windows.microsoft.com/en-us/windows/using-paint#1TC=windows-7
http://windows.microsoft.com/en-us/windows/using-paint#1TC=windows-7
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ADDING A TEXT BOX TO AN IMAGE 

(for Magnification and/or Special Stains) 

1. Open the image in Paint. 
2. Click on the “A” icon (A = text). 
3. Place the box in the lower left-hand corner of the image unless it obscures something important. The box 

can be moved as long as it has the dotted edge. 
4. Select Calibri as the font. 
5. The size should be around 36. 
6. Type in the magnification/special stain/etc. 
7. Select white as the second color. 
8. Click on “Opaque.” 
9. Click on box edge arrows to shrink edges to accommodate text. 
10. Click out of the text box somewhere in the image. 
11. Click on the “Save” icon. 

Select Tool – Use the “Select” tool to select part of an image that you want to change. 

1. Open the image in Paint. 
2. On the Home tab, in the Image group, click the down arrow under “Select.” 
3. Do one of the following: 

• To select any square or rectangular part of the picture, click “Rectangular Selection,” and then drag 
the pointer to select the part of the picture you want to work with. 

• To select any irregularly shaped part of the picture, click “Free-Form Selection,” and then drag the 
pointer to select the part of the picture you want to work with. 

• To select the whole picture, click “Select All.” 
• To select everything in the picture except for the currently selected area, click “Invert Selection.” 
• To delete the selected object, click “Delete.” 

 

CROPPING AN IMAGE 

Use the “Crop” tool to crop an image, so that only the part you select appears. 

1. Open the image in Paint. 
2. On the Home tab, in the Image group, click the arrow under Select, and then click the kind of selection you 

want to make. 
3. Drag the pointer to select the part of the image you want to save. 
4. In the Image group, click “Crop” and everything outside of your selected area will disappear. 
5. To save the cropped image as a new file, point to “Save As,” and then click the file type for the current 

image. Saving the cropped image as a new image file prevents overwriting the original image file. 
6. In the File name box, type in a new file name, and then click “Save.” 

If you will be creating a figure, graph, etc., we have created “Instructions to Create a .jpg from an Image Screen 
Capture from programs that do not allow you to save a .jpg image”. This is available on the TDAC webpage – 
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https://abpath.org/tdac-landing/. We are limited because our remote testing site software requires that all images 
be in .jpg format. If you are unable to convert an image into a .jpg, you may email the image separately to the TDAC 
Coordinator, not attached to the question but with the corresponding question number, and it will be converted 
into a .jpg format. 

  

https://abpath.org/tdac-landing/
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NAVIGATING THE QUESTION SUBMISSION SITE  

Questions entered into the online ABPath Item Bank must include all the fields required by the system. 

 

 

 

 

STEM (REQUIRED) 

The stem of the question is entered in the first box. Icons are available for special emphasis (bold, italics, 
underline), superscript, subscript, insertion of table templates, find (search function), help, spell check, and 
special characters’ table. These functions are in progress, not currently available. 
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DISTRACTORS (REQUIRED) 

- Distractors A through E are available. 
- Each has icons for special emphasis, superscripts and subscripts, special characters’ table, and spell 

check. These functions are in progress, not currently available. 
- Indicate the correct answer by selecting it in the dropdown. 
- Three (3) to five (5) answer choices are acceptable. 

 

Alphabetize Distractors 

When questions are edited, finalized, and moved to the permanent item bank by the ABPath staff, the answers will 
automatically be alphabetized. If you do NOT want the answers in alphabetical order (e.g., a listing of diagnoses 
that range from benign to malignant), select the radio button for “Do Not Alphabetize Distractors.” 
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COMMENTS 

Any explanatory comments concerning the question should be entered here. (Comments are not required.) 

 

REFERENCES (REQUIRED) 

- One (1) reference must be included for every question. 
- Acceptable references include: 

o ISBN numbers of textbooks (page numbers are not required) 
o PubMed ID, DOI, or NLM numbers for articles 
o http links for reliable websites 
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FEEDBACK DIAGNOSIS (REQUIRED)  

- Include on all questions to allow for easier question retrieval and detection of duplicate questions on 
exams. 

- It should be the key words or concept the candidate would need to review to answer the question 
correctly. 

- Examples of feedback diagnoses: 
o Diagnosis 
o Category 
o Concept 

- It is not necessarily the answer (for instance, if you have a list of age ranges), but rather what knowledge 
the question is testing. 

 

ANATOMIC SITE 

Include for image and VM questions. 

 

VISUAL AID CODE (REQUIRED) 

Select from these visual aid code options: 

- Cell Panel 
- EM/Figure 
- Image 
- Table 
- Virtual (Glass): 1-2 glass slides will be sent to the ABPath office for scanning. 
- Virtual (SVS): A thumb drive with svs files will be sent to the ABPath office. 
- Virtual (Glass) + Image: 1-2 glass slides will be sent to the ABPath office, as well as image(s) uploaded to 

the item. 
- Virtual (SVS) + Image: A thumb drive with svs files will be sent to the ABPath office, as well as image(s) 

uploaded to the item. 
- None: No glass slide or thumb drive will be sent to the ABPath office, nor will any accompanying images be 

uploaded. 

Please be precise in your selection, as this information is used by the ABPath staff for tracking purposes. 

 

MEETING DATE (REQUIRED) 

Indicate the year of the TDAC meeting for which the question is being submitted for. 
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SUB EXAM TYPE (REQUIRED) 

Select from these options: 

- Practical with/without Image 
- Virtual Microscopy 
- Written/Recall 

 

NEW EXAM TYPE (REQUIRED) 

Select the examination cohort for which this question is suitable. These choices are available: 

- Core 
- AP/CP 
- SubSpec 

 

CATEGORY CODE (NUMBER REQUIRED) 

Enter the singular, most granular category code. (For more information, see the “Category Code” section in this 
policy.) 

 

CATEGORY CODE DESCRIPTION (REQUIRED)  

Copy and paste the description listed with your selected Category Code number. 
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Upload Files: Upload up to six (6) images in spaces provided. 

 

  



P a g e  | 18 

 

TYPE OF VM SUBMITTED 

 

Item has no glass slide or VM (Written or Practical question). 

The item submitted does not have an associated Virtual Microscopy. 

 

Submit only a glass slide to ABPath. 

Item submitter will be sending a single, or two, glass slides (labeled with the item’s associated accession number) 
to the ABPath. 

 

Submit a glass slide to ABPath with a cropped svs file with a USB Flash Drive. 

Item submitter will be sending a single, or two, glass slides (labeled with the item’s associated accession 
number), as well as a USB flash drive with a cropped SVS file of the scanned slide, named/saved with the item’s 
associated accession number. 

 

Submit a cropped svs file without glass slide. 

The item submitter plans to submit a USB drive to the ABPath containing cropped SVS files named/saved with 
each item’s associated accession number. 

 

SUBMIT (REQUIRED) 

This button must be clicked in order to save the question and image(s). – If required fields are missing information, 
a red alert will pop up at the bottom of the screen indicating what information is missing and must be entered. 

 

EDIT / DELETE 

If you wish to delete a question you have submitted, click on “Question Submission” in the toolbar and select your 
TDAC. Your questions will populate, and you will be able to edit or delete as necessary. 

 

If your institution is unwilling/unable to release glass slides or svs files on a USB flash drive to the 
ABPath, please contact the TDAC Coordinator to coordinate next steps. 
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RESOURCES FOR GOOD QUESTION WRITING 

The National Board of Medical Examiners (NBME) has an excellent resource for question writing entitled “NBME® 
Item-Writing Guide. Constructing Witten Test Questions for the Health Sciences.”  

“Section 2: Writing One-Best-Answer Items for the Foundational (Basic) and Clinical Sciences” is the most 
relevant section, as the booklet is quite lengthy. Their only request is that you maintain their statements of 
copyright. 

There is an excellent, brief video tutorial, that all TDAC members must view prior to item writing: 
https://www2.nbme.org/nbme/IWTutorial/intro/index.html.  

The following YouTube video from Osmosis (Elsevier) entitled “Writing Great Questions for the Health Professions” 
can be another useful resource: https://www.youtube.com/watch?v=LcIgpQRQLc4. 

 

https://www.nbme.org/services/workshops
https://www.nbme.org/services/workshops
https://www2.nbme.org/nbme/IWTutorial/intro/index.html
https://www.youtube.com/watch?v=LcIgpQRQLc4

